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Step 1: Download the Software

To gain access to CERF, you will first need to download the correct version of the CERF client application for Windows or
Mac to your computer from: https://lab-ally.com/download

Contact support@lab-ally.com if you do not have your password to the download page, or_if you want to try the Linux
version.

Step 2: Launch CERF and Log In

When you first launch CERF, the log in dialog will open automatically. If you know what server you want to connect to,
select it from the dropdown list. If you have never used CERF you will need to add a server. Click Edit Servers.

Collaborative Electronic Research Framework™
2 Client Version 5.0.0 (b31)
g Copyright © 2017 Lab-Ally LLC

Terms and Conditions

Server: O amazon s

Username:

Password:

This launches the Edit Servers dialog (shown in the next image).
[ J @ EQit Servers

Servers Server Name: AWS

Server Address: demo.cerfnotebook.com
Server Port 443
Use Proxy
New Server Remove Server
Cancel OK

Click on the New Server button. Enter the server name, server address (which will be either the IP number of your CERF
server, or the assigned domain name) and the port number (see your administrator). You can ignore the proxy settings
unless you are told otherwise. The server name can be whatever you want as long as the address is correct. The Test
Connection button will tell you if this server is up and running. Click OK.

TIP:  The port number used by CERF is decided by your IT team. The default for most servers is 8080. If your server
uses encryption (“HTTPS”), then the port number will usually be 443.
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TIP: The server address will either be an IP number of the form “123.456.789.10” or it will be a domain like “lab-
ally.com”. Don’t include “http” “https” or similar in front of the address.

[ ] Log In

Collaborative Electronic Research Framework™
) Client Version 5.0.0 (b16)
S Copyright © 2016 Lab-Ally LLC
Terms and Conditions

Server: 0 amazon H

Username: userl

Password: esessess

Help Edit Servers... Work Offline Cancel |_Login |

A green icon shows that the server is available. If the server icon is red, it means the server is down. Check with your
administrator or contact us at support@Iab-ally.com .

Enter your user name and password in the Log In dialog and click Log In. The first time you log in to CERF, you may be
prompted to change your password.

If you are using the free trial version of CERF Please be sure to read our Terms Of Use and Privacy Policy.

add production data nor any personal information to the trial server.

You can only be logged in on one computer at a time in accordance with US 21CFR11. If you are currently logged in to
CERF on another computer, or if your session was terminated without logging out, you will see this dialog:

[ ] User Already Logged In

@

User is already logged in at : 172.16.2.1

Would you like to log out that session and log in at this computer?

vo (iGN

Click the Yes button to continue logging in. Clicking Yes will log you out of any other machine or web browser that you
are logged in to.

The first time you run your CERF client software, it communicates with the server and checks to see if it needs to update
itself. Whenever there are updated components available on the CERF server, you will see a message at login and you
will see a progress bar as new components are downloaded and installed. Depending on the age of your server and the
speed of your internet this might take a few seconds or several minutes. The CERF client application may restart itself
after this step to install the new components.

If you are unable to launch CERF, or cannot connect to your server, email support@Iab-ally.com describing the issue and
any troubleshooting steps you have taken. You can find help at: https://cerfsupport.lab-notebook.org
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CERF Tour
THE MAIN WINDOW

When you log in to CERF the first time, this is what you’ll see (numbered arrows explained below):

& & & @

>

» Sessions Collections History Bookmarks Search Tools Help

»;‘ © #E@*m@,\ﬂ |
b= |
:,l_l,\oh\m¢ (1]
b "\, I Name | From | Date T | Reference
“ = General
* . welcome to CERF [Getting Starte ‘ robert one 7/25/19 6:28:19 PM ,_ Getting Started with CERF 5 2019.pdf
1
P welcome to CERF [Getting Started with CERF 5 2019.pdf]
From: }{ robert one
Date: Thursday, July 25, 2019 6:28:19 PM
Reference: B Getting Started with CERF 5 2019.pdf
welcome to CERF ‘

CERF Menu
Bar

Notifications
Pane

Left Panel
icons

Middle
Panel Icons

) © W0

®

The main CERF Menu bar includes familiar tools and some items unique to CERF. The Collections
menu is often a good place to start, as this is where you can create new collections of data
(either Notebooks or File Cabinets) or access existing collections that have already been made
available to you.

When you first log in, the Notifications Pane is displayed in the Middle Panel, and the Right and
Left Panels are hidden. Notifications include items for your attention such as notifications about
signing requests, completed printing tasks, changes to documents, or messages from other
users.

Initially the Left Panel is initially hidden. Select an icon displayed on the left of the CERF
application to open the Left Panel and display one of the panes. The Panes are described in the

section below. The most important is the CERF Document Tree panel , Which is the primary
way that users navigate and view data in CERF. Click here for more information.

When you first log in, the Notifications Pane is displayed. Select one of the icons to open a new
pane in the middle panel in CERF. Click here for more information.

Notebook Viewer — displays the currently “loaded” Notebook Page or Notebook/Section Table
of Contents. To load a Notebook resource, select it in the Document Tree and click the View
button. Click here for more information.

File Viewer — displays files and also the hierarchy of selected File Cabinets or Folders. To view
any file from the CERF document tree, click the file viewer panel selector, select a file in the
tree, then click the “Load Selected Resource” icon. Click here for more information.

Controlled Documents — displays special documents assigned to you for approval and closely
regulated use. Click here for more information.

Structured Data Information Management cards (SDIMS). Can be used to display sets of cards
that represent entities such as samples or experiment summaries. Click here for more
information.

Inbox — displays incoming emails and attachments sent from your registered email address. Click
here for more information.
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Notifications — displays your Notifications (includes links to resources you need to sign or reply
to, as well as resources you have printed). Click here for more information.

Search —launches the CERF search tool within the center panel. Alternatively use the Search
menu at the top of the main window to launch the search tool in its own new window. Click
here for more information.

8

Initially the Right Panel is hidden. Click the Info icon ﬂ to show the Right Panel and display
annotations, metadata, version history, signature block, and status for the resource selected in
the Document Pane. Click here for more information.

Right Panel
Info

Actions apply to a selected Notification: Refresh Notifications, View, Reply, and Delete. Click
here for more information.

Notifications
Toolbar
Display one or more of the available panes in the Left Panel by clicking on the icons shown to the left of the CERF

application. To hide a Pane, click the X in the upper-right corner of that Pane. Panes available in the left-hand panel
include the Document Tree (also called CERF Tree or just “Tree”), Bookmarks pane, Saved Search pane, Local Files pane
and Checked Out Documents pane, also sometimes called the “Checkout Tray”.

Experiment with adjusting the proportions of the Left, Center and right-hand panels by dragging the panel borders left
and right or up and down so that you get used to optimizing the layout of the CERF interface to suit your current needs
and screen size. It is possible to adjust the interface so that you see all three panels, any two panels, or even just a single

panel if that is all you currently need. Hover over the panel borders to see the border drag / panel resize indicator +

DOCUMENT TREE

Click here for more information on the Document Tree.

=
The Document Tree also called the CERF Tree or Navigator is where “Collections” (NotebooksE , File Cabinets = ,or

Notebook CoIIectionsQ) are displayed.

Click on the Documents icon ==/ to open the Document Tree. When you first log in to CERF you will see your personal
File Cabinet, identified with your username, in the Document Tree. Drag and drop files into this File Cabinet. Now right-
click on items anywhere in the Document Tree to expose the contextual right-click Menu.

Click here for more information on Document Tree icons and here for the Document Tree toolbar.

TIP: If you are totally new to CERF, when you log in for the first time you will most likely see a single
collection in the CERF tree. This is your personal file cabinet and it will probably have the same name as
your username. Start by dragging some files or folders from your computer to this file cabinet.

Click the expander next to the File Cabinet

‘ J x dggwg SEEGEY to see the hierarchy in the left-hand tree
3o H+E O e R ©  panel, or click the view icon at the top of
2 e . the left panel to display the hierarchy in
/ S the center panel. When you copy a folder
| Yo from your computer to a File Cabinet,
g::::jj}jjj:jjjj;:;““ CEREF faithfully recreates your folder
B o hierarchy along with all the files,
e E‘”“ organized exactly as they are on your
B oot pueis computer. Right-click on the items you
- just added to explore the right-click
[ o o s menu options.
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Shown below: examples of right-click menus and sub-menu options for three different resources: 1) Edit menu for an
MS Word file 2) Edit menu for a finalized image file. Note the restricted choices. 3) Notebook sub-menu for a Notebook
page. 4) View In sub-menu for a chemistry file. “New CERF Window” will display the file in a popup. The different
options available in different contexts help maintain compliance and provide appropriate choices for different situations

and users.
2 & o x &
+ o s - y =Y . = s o
LOE+E OL iV BE - e EB+E OL iy B e n
‘ E rjday — —
)y 01 ONE OF EACH FILE “ E rjday
(=) B & certogouieqt).pxm ﬂf 4 ___ 01 ONE OF EACH FILE
? View 5 B @Y cerflogotile(1).pxm
4 ViewlIn > . View
| View Resource Info B Worm genomic Sout View In > :
Add Bookmark 3 . '
Cut g8 porphyrin.cmi View Resource Info [
i Print > Copy % IM-0001-0002.dcr Add Bookmark
¢ Tools > Paste b Copy
Digital Signatures > image003.emz "
b »  Check OutAnd Edit — 9 Print >  Paste
2 Notifications » | CheckOut |z Plant_cell_structure.  Tools > _
l Ll Edit Metadata t & 03pGEM_(AB)_A01  Digital Signatures »  AddRelation
elation = 4 . X
B Search > lecti
Remove from Collection E SigmaPlot Embedde Notifications > Remove from Collection
Set Resource Access = Pé4-sequences.aln  Controlled Documents »  SetResource Access
Delete reaction.cdxml Inactivate
Inactivate N
Archive Archive
Finalize
[ ] (e} () [ ]
=] =]
LoE+E 0L ilv Bl B |LoE+E 0L ilv BB AR
= = 1 N = AAHE SR AHL s
W E 9 joens cerr work W B ey
ity 2 01 enries iy 01 ONE OF EACH FILE
5 - Vi —— 5 B (s cerflogotile(1).pxm
ew o
View In > B Worm genomic Southern blots.doc
Il View Resource Info Pl
Add Bookmark | View
| Edit > View In [ Center Panel
Notebook il New Entry . View Resource Info New CERF Window
| Print »  New Entry From Template Add Bookmark
Tools »  Add Placeholder ‘; Edit > External Application
Search 4 . Print >
I Notifications »| StrikeOut I ool p dsx
118, 6-19-19 Use Controlled Document oo _
- s Show All Inline 2 Digital Signatures >
i 119.6-20-19 Finalize My Entries E Search >
| New Structured Data Entry 1 Notifications ~ ~  »
Set Resource Visibility

the type of resource, its current location, and your access role.
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TIP: Many users like to keep CERF open on their screen all the time but adjust the layout of the panels by dragging

the boarders left and right with the drag tool + 5o that only the CERF Tree (Left panel) is visible. This minimizes
the screen space used by CERF during periods when the full Notebook viewer is not needed.

TIP: The right-click menu is used extensively throughout CERF. Although many of the functions in the right-click
menu can be accessed using icons in the various CERF tool bars, power users quickly learn to use the right-click menu
and associated keyboard shortcuts instead. Almost any resource displayed anywhere in CERF can be used with the
right-click menu. The items shown in the right-click menu and various sub-menus will vary significantly depending on



-

CHECKED OUT DOCUMENTS &

Next click on the Checked Out Documents icon. This Pane displays a list of checked out documents or files. When you
check out an item for editing, a copy is downloaded to your local computer, kept in a special location, then deleted
automatically when you check the item back in. You can select Items in the Checked Out Documents pane and chose:
1) Check In to return an edited version to the server, 2) Uncheckout to ignore any changes you have made and return
the item to the server. 3) Edit to open previously checked out items for editing in a suitable application. Note that any
time you edit a checked out document, the name of the item will turn red, indicating that CERF has detected changes.
Click here for more information on checked out documents and here for an explanation of the toolbar.

TIP:  Keep an eye on this area to make sure you don’t have files checked out for editing that you are finished
working with. A good best practice is to return checked out files to CERF promptly so that they are available for
editing by others with permission to access to them.

BOOKMARKS W

Click on the Bookmarks icon to show your bookmarked items. You can bookmark a resource by using the right-click
menu option, the main menu, or by dragging a resource from the Document Tree to the Bookmarks pane. This makes a
link to resources you want to access quickly. Click on the small x in the upper- right corner of this pane to hide it.
Bookmarks always point at the most recent version of a resource that is under version control. Click here for more
information on bookmarks and here for an explanation of the bookmarks toolbar.

SAVED SEARCHES Q'F

Click on the Saved Searches icon. This pane displays any previous searches you have saved. You can run a saved search
again. Use saved searches to create dynamically updated “smart cohorts” of data. Click here for more information.

LOCAL FILES B2

Click on the Local Files icon to show your local file system. You can mark local directories as favorites and these are then
easily accessible as a source for drag-and-drop import, or as a destination for drag-and-drop export. Using this pane
saves users from having to open a separate Windows file Explorer or Mac OS Finder window, although you can also
drag-and-drop items in to CERF from those windows too if you like. This is often more convenient that opening the
finder (mac) or file explorer (windows). Click here for more information.

MANAGING COLLECTIONS

A “Collection” in CERF is a container that holds other resources (such as documents, data files and records of work
performed in the lab). Keeping work divided into collections makes your data easier to manage and helps keep projects
separated. Click here for more information on collections.

The Show Collections dialog (Collections menu) displays all collections (Notebooks, File Cabinets, and Notebook
Collections) that you are permitted to access. There are three types of collections:

1. File Cabinets (think of these as being like Hard Drives in which you can store and organize files),

2. Notebooks (use these to tell the story of your research activities and to build workflows (called templates) that will
help your lab achieve reproducible results.

3. Notebook Collections (a tool for bundling together related notebooks).

TIP:  Keep your collections limited to a sensible size. File cabinets should contain less than 1000 files. Consider
starting a new notebook for each new project or after 100 pages.
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SHOW COLLECTIONS

When you belong to a Workgroup, you will be able to access any File Cabinets, Notebooks, or Notebook Collections
owned by that Workgroup. If the Document Tree is hidden, click on the Document icon to display it. Now chose
Collections > Show Collections from the CERF menu bar.

The left panel of the Show Collections dialog displays all collections you currently have “mounted” in the Document
Tree. All the available collections (i.e., collections to which you have access) are shown in the right panel. If you wish to
work on documents in a particular collection, you’ll need to mount the collection first. If you are new to CERF you may
not see any collections here except your own personal File Cabinet, which CERF makes automatically for all new users.

0@ Show Collections
Shown Collections: Other Collections of type: = All Types | <]
E Protocols, Images, and Resource Matching text:

é Lab-Ally _ Staff -work folders

p— a Algae Articles

[= Protocol Documentation E

— Aptamer Test
MSDS. 1

g E Cerf-Notebook.com
Reagents.1

E @ Collection
Samples.1

E demo mike

K& povmer srience

=1 File Cabinet Uno

Collection:
Owner:

My Role:
Description:

@
@ Search For Collection New Collection... Sort Collections Show lide Close

1. Click the drop-down list to display All Types of Collections: Notebooks, Notebook Collections, and File Cabinets.
Note that there are several ways to find collections. This is particularly useful if there are many to sort through. You
can type text into the Matching Text box in the right pane or you click on the Search for Collection, which gives you the
option to Search or Browse. Note your role in the owning Workgroup (shown in the lower left part of the Show
Collections dialog).

2. If you see collections in the right-hand column, select them and click on the Show button. The selected collections
will be mounted in the Document Tree. If a collection contains resources, there will be a small triangle “handle”
displayed to the left of the collection. To expand a collection, simply click on the handle.

HIDE COLLECTIONS

You can easily hide collections that are mounted in the Document Tree. Sometimes this is helpful when you have a lot
of collections that are cluttering up the workspace.

1. Select a File Cabinet or Notebook in the Document Tree.
2. Click on the Hide Collection button E.;J in the Document Tree toolbar.

3. To find the collection again, select Sessions | Show Collections.

TIP:  You can hide or show multiple collections at once from the Show Collections dialog. Use the control or
command key to multiple-select collections. As a best practice, try to only mount collections that you need and hide
them when you are not using them. You can use the CERF search tool to find items in unmounted collections if you
need to.

Click here for more information on how to show/hide collections.

VIEW RESOURCE INFO

1. Select a Notebook (or Personal File Cabinet) in the Document Tree.

2. Clickon the Info button X at the top of the Document Tree to show the Resource Info in a new window or right-
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click and choose “View Resource Info”. There are several panes in the Resource Info that can be collapsed and
expanded as needed. The Status Pane shows important information about the ownership and edit condition of the
selected resource in the Document Tree, and displays the unique CERF ID for that resource. Click the blue Owner link to
see a list of all users who can currently access that resource. This list also shows each user’s access role to that resource.

] [ ] Resource Info: IMG_1060.jpg

B MG 1060.ipq

Vertical Resolution: 72.0
Resolution Unit: Inch
© Equipment
Equipment Make: Apple
Equipment Model: iPhone 5c
Shutter Speed: 1/120 sec
© Location
Latitude: 30.264303
Longitude: -97.7676

Edit Metadata

3\

= Status (fi,'

Edit Status:  Version Controlled

Owner: ‘9% robertl
My Role: e Role Cosigning Role
Closed: > Rob One Notebook Creator
Chéckgd‘Out: { Deb Supelak File Cabinet Editor Peer Review Digital Signer
:2“;;';2’43 il '» : Robert Eleven Notebook Editor Peer Review Digital Signer
| 74 Alex Martinson Annotator Peer Review Digital Signer
#{ Robert Fourteen Guest
—W s Robert Twentytwo Notebook Creator Peer Review Digital Signer
Close

TIP:  You can also select items in the Document Tree then click the blue “info” v button at the top right to see
the same information in the right hand Panel. Get into the habit of looking at the Resource Info often to understand
more about your data, how it is being used, who can access it and who has recently edited it.

FILE CABINETS

File Cabinets are your file management system in CERF—this is the place where you can organize, edit, share, and store
your data, protocols, literature, samples, etc. When you add files to a File Cabinet, they are stored on the CERF server.
Click here for more information on file cabinets.

PERSONAL FILE CABINET

When you first log in, you should see your personal File Cabinet E mounted in the Document Tree and identified with
your username. This is owned by your personal Workgroup. All new users are initially provided with at least this single
collection. Your CERF Administrator may also have created other collections for you before you log in for the first time.

TIP: It is important to understand that in CERF, resources are not owned by individuals, they are owned by
Workgroups. A Workgroup certainly CAN correspond to a single individual. When you first log in to CERF you may be
the only member of your personal Workgroup. Over time your administrator may add you to other Workgroups, add
other users to your Workgroups, or you may be given permission to add other people to your Workgroups. You can
keep track of who can access resources at any time by looking at the Resource Info > Owner > then click the blue

owning Workgroup name next to the Workgroup " icon to see a list of everyone who can access that resource.
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CREATE A NEW FILE CABINET

Note: you must have the role of File Manager (or Notebook Creator) in at least one Workgroup in order to create a File
Cabinet.

=+
L=
1. Click on the New Collections button in the Document Tree toolbar ;j and select File Cabinet.

[ J [ New File Cabinet
Title: Test File Cabinet

Description:

A place to put training files to work with.

Make File Cabinet public
© Set owner workgroup of File Cabinet

Workgroup: rjday 2 @

Visibility: © shared | Private

(o3}

Signature Workflow:  Peer Review Digital Signer
Template:

Empty File Cabinet Template
Basic File Cabinet Template

Cancel

This launches the New File Cabinet dialog
Enter the title and a description for the File Cabinet. The File Cabinet title must be unique.
Leave the other settings in their default state.

Select the “Empty File Cabinet Template”. Note that other templates may be available as well.

o v & w NN

Click on Create to show the new File Cabinet in the Document Tree.

CREATING FOLDERS

1. Select the File Cabinet you just created.

2. Click on the New button (circled below) in the Document Tree toolbar and select New Folder:

GERE oLt

o " New Folder ]
N m Add Resource

3. Inthe New Folder dialog, enter a name for the Folder.
4. Click OK. Expand the File Cabinet to see the new Folder.

Click here for more information on folders.

ADD CONTENT TO THE FILE CABINET

1. Expand the File Cabinet to show the Folder(s).

2. Select a File from your computer and drag it to the File Cabinet or a Folder within a File Cabinet. You can also right-
click a File Cabinet or Folder, select Edit > Add Resource, choose the file you want to add and click “Add to CERF”.

3. If the Edit Resources dialog opens and asks if you would like to edit the incoming file’s metadata, select “No.” This
will add the File with the default metadata and Resource Type.
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TIP:  You can choose to not add new metadata to incoming resources by selecting “Quick Add” in the preferences.
This is recommended for most users. You can always add metadata to new resources later. Turn off “Quick Add” if
you need to add metadata to all new files or designate files as being of a specific resource type, which may then
allow you to add custom metadata associated only with that resource type.

4. Expand the File Cabinet or Folder to see the new file you just added.

5. Select the file (click on it once) and click on the View button o in the Document Tree toolbar, or right click on it
and choose “View”. This will open the file in the CERF File Viewer in the center panel. “View In > File Viewer Window”
will display the file in a new window if CERF has a suitable viewer plugin. “View In > System Default” will open the file for
viewing in a suitable external application.

TIP: Do not try to edit a file that has been opened in view mode with an external application. Some applications
will allow you to start editing the file, but then you will find that it will not let you save your changes. Do not try to
use “Save As...” . If you DO want to edit the file, close the window and click Check Out and Edit instead.

6. Select a file you imported and click I Review the Resource Info. When a resource is added to CERF, it is given a
unique identifier as well as certain other CERF metadata. The Resource Info always includes the creation time and date,
(i.e., when the file was added to CERF) the person who contributed the resource, the Resource Type (i.e., document,
image, etc.) and other information. CERF also automatically extracts and displays any embedded metadata (often called
“file properties” in MS Office documents and images). The metadata, embedded file properties, full text of most file
types, and anything else that CERF knows about this file are all indexed for searching at the time of addition so that you
and your colleagues (with the right access role) can find the file later using the CERF search tool. You can click the + and
—icons to collapse or expand the various sub-panels in the Resource Info window in order to show or hide different
types of metadata about your resource.

7. The CERF unique resource ID can be especially useful for citing and locating links to a specific file wherever they
occur in CERF. ALL files, folders, collections, and other resources in CERF have a unique ID. Expand the “Status” sub-
panel and double click the ID in the Resource Info to select it. Now use control-copy or command-copy to copy the ID
number.

-
[C] Resource Info: Chlorella2.jpeg
B Chlorella2.jpeg

© Relations and Annotations

b4 w
Rating:

© Thumbnail

@® Metadata @)

© Status @)
Edit Status:  Versionable
Owner: 494 robertl
My Role: Annotator
Closed: No

Checked Out: No
Visibility: Shared

Compliance:
1d] 131252 [Federation: 43065, Server: 101)

Close
[

8. Go to the CERF Search engine (using either the central panel, or use the “search” menu to open the search tool in a
new window). Click Add Search Parameter and select CERF Resource ID. Click the X on the right to remove any other
unnecessary search parameters. Now use control-v or command-v to paste in the ID you copied above and click Search.
You should always only see ONE result listed when you search for a CERF Resource ID this way.

Page 10 of 22



Right-click on the search result, shown below in the center panel. Note that the full right click menu is available for each
item in your search results. From here you can choose to view the resource, send notifications about it to colleagues
that have permission to access it, or perform other actions. To determine the location of this resource in your Document
Tree, right-click and choose Search > Navigate. The item will be highlighted in the Tree. Any containers it is in will be
automatically opened and if necessary, the collection the item is in will automatically mount in the Tree, and you will be
alerted if this file exists in multiple locations.

[ ] @ CERF v5.3.0 - Logged in to attic vpn as rjday
8 X 3 E&=ERa|f
\ =+ = . -
e E+E oL i¥ o
1) B roberts ICERF Resource ID is B BRs2 I @®a X
Eﬁ sam-01.jp2 @
E B sam-01L.tif Add Search Parameter O And or Reset Search Find Experts Search g
Al fold
[y Algae folder Showing 1 to 1 of 1 results.
[ chiorella 1D Title Versi... Collection Contributor Created Updated Size Sco...
B crioretatipeg 113 L i | Jrobentl __[RobOne ______[Sep6.20226:59:5..[Sep 6, 2022 6:59:5..]10 KB
B B0220Chlorella_closeup.00( View
View In >
B chlorella_vulgaris-1.jpg View Resource Info
B chlorella_vulgaris.JPG Add Bookmark
Edit >
Print >
B images.jpeg Tools >
B Proposed-ife-cycle-Trgehl Search > Navigate
B norell . ' Notifications > Locations...
chlorella transfection plate.
B Caverpa Previous Next © view 4Nav|gale @ save [ Export
N —
\ [ =4

9. Use Right-click > Search > Locations... to see if the resource exists as links or multiple current versions in more than
one location. Use right-click > View Resource Info on any resource to open a new info window then scroll to the bottom
of the window to see if there is a version history. If so, the resource you right-clicked on will be highlighted in the list,
allowing you to immediately determine if there are older or newer versions of this resource in CERF.

TIP: using intelligent Boolean search strategies in conjunction with resource content and metadata to locate
specific resources is a key CERF skill.

TIP:  You can drag items in the search result list to other locations, including destinations in to your local files panel.
This can be used to quickly locate and export a copy to your local computer.

@ Export

TIP:  You can use this icon wherever you see it in CERF to export a .CSV or text file containing a
summary of in the current window, including search results.

BATCH ADDITION

1. Select a directory on your computer that contains several files you want to add to CERF.
2. Dragthe entire directory to CERF and drop it on the File Cabinet you created.

3. If you see an Edit Resources dialog popup asking if you want to edit the metadata for these resources, select “No.”
This will add the directory and its contents with the default metadata and Resource Type. The Advanced Training will
demonstrate how to tell CERF that incoming files are a special Resource Type and how to add rich, custom metadata for
the whole batch.

4. The directory and its contents should be displayed as a new Folder with contents. These documents are now saved
to the CERF server. Note that you can drag in a directory that contains many nested subdirectories, and CERF will
always maintain the hierarchy just as it was on your local computer.
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VIEW IN CERF USING THE FILE VIEWER @

You can view many types of files in the center panel or in a separate window. You can also select items in the left-hand
CERF tree and display the expanded hierarchy of that item in the center panel. To view resources a file in the CERF File
Viewer, do one of the following:

Select a File Cabinet or Folder in the tree and click the view icon © to load the File Viewer in the center panel. You
can also use the right-click > View menu with almost any resource anywhere in CERF to view it with your preferred
method. In options / settings you can also set your double-click action to “View”.

L)
Use the “view in new window” icon to view an item in a new adjustable window.

Use the “view in external application” icon @ to open a read-only copy of the file in your default application on your
computer. This can be especially useful when you only have read access to a resource.

Note that if you have the “Guest” role you can ONLY view items in CERF and if you have the “Resource Identifier” role
you will not be able to view them at all.

When you load a navigational tree or sub-tree in the center panel, you can use breadcrumb icons at the top of the
center panel to navigate up or down within a File Cabinet hierarchy, then click the file you want to view.

Click here for more information about the File Viewer.

VIEW VERSUS CHECK OUT

To view a file with a suitable external app installed on your local computer:
1. Select one of the files you just added to CERF.

2. Right-click any file icon and chose “View In > External Applications. This will automatically launch an appropriate
external application on your computer.

3. A message will appear telling you that you are about to view a read-only copy. Click OK.

4. The read-only copy will open in the native application for this file. A suitable application must be installed on your
computer. CERF will tell you if it cannot find one there.

5. Close the file when you are done. If you made any changes they will NOT be saved. Do NOT attempt to “save as” or
similar as this may cause you to save a copy outside of CERF which is not a best practice. Always try to keep everything
safe and secure in CERF.

To Check Out a file:

1. Select the same file you used in the previous exercise.

2. This time, double-click on the file or right-click > Edit > Check Out and Edit.

3. The file will open in edit mode. Note that the native application for the file must be installed on your machine. CERF
will tell you if it cannot find one there. For some sorts of files created in CERF itself (e.g. CERF Tables, CERF HTML text
entries and SVG files in Notebooks) , CERF already includes the applications necessary to edit the file and will
automatically check those files out with its own editing tool.

4. Close the file without making any changes.
5. Note that there is now a red check-mark Vnext to the file showing that it has been checked out from the server.

When a file is checked out, no other user who has access to it can make changes to it, but they can still view the last
version. The file will be displayed in the Checked Out Documents pane to the right.
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6. Select the document in the Checked Out Documents pane. Click on the Uncheckout button n This will return the
document to the CERF server, unchanged.

7. Now select the same document in the Document Tree.

8. Click on the Checkout and Edit button IL on the Document Tree toolbar. The file should open in the default
application on your computer for that file type.

The document will once again have a red checkmark next to it in the Document Tree and will be shown in the Checked
Out Documents pane. You can Mouseover the red check mark to see a yellow popup box that shows who currently has
the file checked out. Whenever you work in CERF you may see these red check marks appear and disappear in your
Document Tree as other users checkout files and check them back in again.

9. Make a small change to your checked out file using the application that checked the file out, then save the file. Note
hat the name of the file turns red in the Checked Out items Pane indicating that CERF has detected a change. Close the

window that the file opened in, and now check the file back in using the Check In button IL in the Checked out items
pane. If you don’t close the editing window before attempting to check the file in, CERF will remind you that you need to
close it first.

Locate the recently edited file in the Tree and look at the Resource Info. Depending on how your server is configured
you will usually see a version history for the item you just edited at the bottom of the Resource info area, with versions
1.1 and 1.2 visible. Right click on either version to see the usual options for BOTH versions.

Click here for more information about the Check Out & Edit feature.

TIP:  You can change the default double click action from edit to view in the CERF application Settings (Mac) or
Options (Windows).

TIP: understanding the mechanics, available options and variations of CERF’s powerful round trip editing system is
a key skill for all CERF users.

TIP: CERF can treat files as “versionable” meaning that the file can be completely overwritten with a new version,
or files can be “version controlled” meaning that all versions of files are kept and are visible as a version history list
in the Resource Info. For most users we recommend that the Default Document Edit Status in your Preferences /
Options should always be set to “version controlled”.
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NOTEBOOKS

While File Cabinets are your file management system, think of Notebook as the place where you tell the story of your
research, either chronologically or by topic. Your Notebook is a place where you can record your work and visualize it,
just as in a paper notebook. It’s also a place where you can build templates for repeatable workflows, structured data
collection instruments or checklists of tasks that need to be performed in a specific order. Click here for more
information about Notebooks.

CREATE A NOTEBOOK

=+

i =
1. Click on the New Collection button E’J in the Document Tree Toolbar and select “Notebook.” This action will not
be enabled unless you are a Notebook Creator in one of your Workgroups.

This launches the Create New Notebook dialog.

[ SN ) Create New Notebook

Title: |

Description:

Workgroup: igamar v
Notebook Compliance: Flexible

Visibility: © Shared Private

Signature Workflow: Peer Review Digital Signer o

Specify a notebook type:

Empty Notebook Template
Basic Notebook Template

(2) Cancel OK

Enter a unique title for the Notebook and a description (required).
Select your personal Workgroup from the drop-down list of Workgroups.
You may have a choice of a Flexible or Rigid Notebook. Select Flexible.
You may have a choice for Visibility. If you see this, select Shared.

For Signature Workflow, select Peer Review Digital Signer from the drop-down list.

N o v & w N

Select Empty Notebook Template from the list of template and click OK.

8. Look for this new Notebook E in the Document Tree.

NOTEBOOK PERMISSIONS

Your permissions (allowable actions) are determined by your access role in the Workgroup that owns each Notebook. In
the case of the Notebook you just created, you are a Notebook Creator — a role with the highest permission level. To
find the owning Workgroup and your role in it:

1. Select the Notebook (or any Resource) in the Document Tree by clicking on it once.

2. Click on the Info icon displayed in the upper-right of the CERF interface. This opens the Info Pane in the Right Panel
(or click on the Info button in the Document Tree, as described earlier).

3. Inthe Status pane, find the name of the Workgroup.
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4. Click on the Workgroup name to display all the members of the Workgroup and their access roles and signing roles.
You can click the name of a user in the list to trigger a new email addressed to that user.

5. Note that your access role for this Notebook is displayed in the Status panel.

TIP: If an action you want to perform seems to be missing from the right-click menu or the icon is greyed out in a
tool bar, select the resource in the Document Tree, open the Resource Info and verify that you have an access role
that allows that action. Send a notification to the Workgroup Administrator requesting a role change if necessary.

ACCESS ROLES

Your permissions may differ from one collection to the next, depending on your role in the owning Workgroup. Some
right-click menu actions may be absent, some of the toolbar buttons may be grayed out, and some drag-and-drop
actions may not be allowed if your role does not give you permission for an action. CERF keeps track of all of your
allowed actions for different resources in the background. Click here for an explanation of Access Roles.

CREATING NOTEBOOK SECTIONS

Sections provide a way to organize the content of your Notebook. You can make multiple sections in a Notebook and
nest them hierarchically if you like.

1. Select the Notebook you just created.

2. Click on the New button (circled below), select New Section.

HE@®E Ol i
> E Proi  New Section

= New Page
g % Prof New Resource Page
> |5 Reagents:1

3. Inthe New Section dialog select the Empty Notebook Section Template (a Basic Section contains one blank Page; an
Empty Section has no Pages). If other templates are available, they will be displayed in this dialog.

4. Enter a Title for the Section (optional). You can rename the section later.

5. Click OK.

6. Click on the expander next to the Notebook to display the new section. Select the section and click the New button
again, then select New Page to add Notebook pages to a section.

PERFORMANCE AND NOTEBOOK SIZE

In order to maximize performance (i.e., the time to load a Notebook Page), we suggest that you add no more than 30
Entries on a Notebook Page. Keep in mind that a Notebook should have no more than about 30 Sections per Notebook
and no more than about 30 Pages per Section. In CERF just like in the paper world, it is a good best practice to divide
your work logically into Notebooks that might represent discrete time periods (e.g. 1 month or 1 year), or specific
discrete projects. Always limit your notebooks to a sensible size. You can make as many Notebooks as you like in CERF
so there is no reason to try to fit too much work in a single notebook. Administrators can set a hard page number limit
in the business policies area if they like. We recommend this be set to not more than 300 pages.

CREATING PAGES

Pages in the CERF Notebook are like Pages in a paper Notebook, except that the Page can include your notes, images,
tables, voice recordings and files of all types.

1. Select the Section you just created
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2. Click on the New button and select New Page or right-click on the section and choose Notebook > new Page.
=
G EHE oL

- E Rob New Section
~

e e
' r Renee's project
’ O s icerfixe

-

| 6.Page audio

3. Select the Empty Notebook Page Template in the New Page dialog. There may be other sorts of page templates
available. Enter a new Page title and click OK.

When you create a new page, it will open in the Notebook Viewer (in the Middle Panel of CERF). You can open (load)
an existing Notebook Page that is displayed in the Document Tree by double-clicking on the Page OR by selecting the

Page and clicking on the View button O in the CERF Toolbar.
Click here for more information on notebook sections and pages.

TIP:  Although anything in CERF can be made into a template, the most commonly used type of template in CERF is
Notebook Page template. It is a common convention in labs that a notebook page represents a specific unit of work
like a protocol, workflow, experiment or a standard period of activity like a day or a shift. The use of notebook pages
as templates is facilitated by the use of special entries called Placeholders. These can be used as receptacles waiting
for data that is not yet available. To turn any Notebook page into a template, right click on the page icon or the
bottom of the page itself and choose tools > create template.

CREATING ENTRIES

You can always add content to your personal Notebooks, but in Notebooks owned by other Workgroups, you must have
a role of at least Notebook Editor to add files or make changes. There are several ways to create new entries on a
notebook page. Some of them are described below.

Click the “new entry” toolbar button then choose your entry type from the menu (shown below). If you are new to CERF
you should certainly try creating at least one of each of these entry types on a test page. You will need to have
appropriate Applications on your computer for working with MS Office files, .txt files and mind map files. Click here for
an explanation of entry types.

. E Section > 1_ 1. Page
> (@i v]fla
SN— F—
iAMEnt  Text hl
Drawing
Structured Data >
Table
Microsoft Word
Microsoft Excel
Mind Map
Audio Recording

Quick Add File...

Add File...

From CERF resource...
From Template...

Add Placeholder...

4. Click anywhere on the blank portion of the page to open a new CERF text entry. Experiment with the text editor
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tool bar to see what kinds of content you can create here. Technically this tool is actually an HTML editor, which means
that a range of styles and elements like simple tables are all supported. Note that you can even copy the page source
from simple third-party websites, click on the HTML source tab and paste that code into the text editor to recreate the
basic layout of the web page in your Notebook entry. Click Create Entry to finish editing. You can subsequently checkout
this entry for additional editing at any time.

5. Toadd aresource to a Notebook page from a File Cabinet: Expand a File Cabinet in the document tree, select a file
and, while holding down the mouse button, drag it to the whitespace at the bottom of a Notebook Page. You can
collapse other Entries on the Page to give yourself more room to better see any entry that is displayable by CERF.

@ @ CERF v5.0.0 - Logged in to attic as robert1
E HRELEDs
E Rob's Lab Notes > ‘_ 1. Page one, samples ”

]
v

BFed¢

Lo te» B Hilbsla6|F T T
SAMPLE-1002 (Rob One, Wednesday, October 26, 2016 4:00:38 PM)

SAMPLE-1001 (Rob One, Wednesday, October 26, 2016 4:00:38 PM)
text.rtf (Rob One, Wednesday, October 26, 2016 4:34:42 PM)

+

(@)

icerf placeholder test (Needs 2 Document) @

+ text in html (Rob One, Wednesday, October 26, 2016 4:39:44 PM)
S new (Rob One, Friday, November 4, 2016 7:09:37 PM)

: = - - :

o 4 L EOT il BB e @D
This text file is expanded so that the content is displayed the other entries above have been
collapsed to hide their content. Experiment with the Notebook Page display icons in the red
rectangle above to see how each of them affects the layout and appearance of your Notebook
pages.

Save Save and Check In Cancel

| | =9

Note that you can also select multiple files and add all of them to the page at once. CERF will ask whether you want to
create a completely new resource (with a different resource ID), or whether it will be treated as a version that can be
traced back to the original copy, or whether you want to create a link (i.e. exactly the same resource made available in
both places).

There is also an option for adding the item from the file cabinet not as a Notebook Entry but as a “Relation”. Relations
are way of showing that this Notebook Page is merely related to the item in the File Cabinet. Creating relations between
items using drag-and-drop (or copy and paste) and telling CERF to treat the items as relations is a good way to illustrate
relationships between different resources in CERF. Relations for a given resource appear as a list at the top of the
Resource Info window or panel. Click here for more information on relations.

TIP:  CERF will often prompt you to say more about what you want to do when you drag and drop items within
CERF. The options offered to you depend on what you are moving, where you are moving it to, your access role for
that resourcce and other factors. In general, try to create Links and Versions to avoid filling CERF up with replicate,
identical copies of files in different locations, and try to build consensus in your organization about where to store
and who should have access to your various resources. Always Use abundant metadata to make the purpose of, and
difference between similar files and version clear to your downstream audience in the near and distant future.
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TIP:  You can use the right-click > Copy and Paste commands, OR the Copy icon in the document tree (and the right-
click > Paste in on the Notebook Page) to accomplish the same thing. You can also drag and drop resources to
Notebook Pages directly from many other locations in CERF, such as from a CERF search results list, from other
Notebooks and from your email-to-CERF inbox. Additionally, users can even drag specific versions of resources from
the CERF Resource Info window. To use an older version of a resource, open the Resource info in the Right Panel,
locate the older version in the resource version history, then drag the desired version to your notebook page. Users
can also drag data cards from the Structured Data Information System panel and SOP’s from the Controlled
Documents panel by dragging them from that panel up to the Notebook icon at the top of the interface. The center
panel will instantly switch to show the current notebook page so that you can now drop the item onto the page.

6. You can drag-and-drop files from your computer file system straight into the Notebook Page or onto the icon of the
target Notebook Page in the Document tree.

7. You can also make new entries by right-clicking on a Notebook Page icon in the document tree, or in the blank
space at the bottom of a page. If you have the right access permissions, you can then choose Notebook > New Entry to
open the New Entry dialog. Select the type of entry you want to create then click OK.

[ ] ® New Entry

Title: Jun 11, 2018 5:29:35 PM Entry

Entry Source:

File Browse...

(No File Selected)
© Resource Search...

(No Resource Selected)
Text

Cancel

8. You can right-click on Notebook Page icon or on the page and chose Notebook > New Entry From Template to
choose from a list of available page templates that you and your colleagues have previously made.

TIP: Notebook entries are technically containers with a single file inside. The Entry and the Entry Content can have
their own independent metadata so that users can better annotate them within a specific context. For example, an
image file used as an entry might have its own keywords, but if that same file is used in more than one notebook,
then the entry metadata used to describe why that same file was used (or what else that entry is related to) may

well be different in different places.
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VIEWING DOCUMENTS INLINE

Many file types can be displayed on notebook pages or in the CERF File Viewer so that you can see the content of the
file without opening it in an external application. You can choose whether you want to see the content of files inline or
as a simple icon (i.e., a link).

1. Click on the blue selection bar to select an Entry containing a file type that CERF can display inline using it’s built in
viewer plugins. Click on the Change Display Type button (shown below) on the Entry toolbar and select “Show PDF
Preview.”

Note: A Business Policy determines the maximum file size that can be displayed inline; thus you may find that some files
cannot be displayed inline (in that case, you can use “View In > System Default” to view the file with an external
application.

S Northern Blots.doc (Iman Qamar, Friday, October 21, 2016 3:38:04 PM)
O, L LU OT ik BE o &0

a h‘/ show Lin
& ohow PDF Preview

If you create a Notebook Page from a template, then the files in that page may not initially be displayed inline. To
display ALL the files on the page, right-click on the Page icon in the CERF Document Tree and choose: Notebook > Show
All Inline.

TIP: If a file cannot be displayed inline, CERF offers the option to display a substitute file instead using the Set
Official Print Copy function. This allows the user to display anything they want (image, text, PDF or other file) to
represent the underlying data file.

EDITING ENTRIES

Use the check out and edit function ( L icon in the edit toolbar, or right-click > Entry Content > Edit > Check Out and
Edit) to edit any entry. CERF will automatically determine if the entry should be edited by one of the applications built
into CERF or passed to an external helper application for seamless round trip editing on your local computer. Checked
out Resources are listed in the Checked Out Documents panel on the left. It's good practice not to check out more items
than you need at any one time, and you should be sure to check items back in when you are done editing them.
Generally you should always check in edited files as new versions and you should tell CERF to update references to the
edited files in all collections.

TIP:  You can tell CERF which Applications on your computer you would prefer CERF to use for viewing and editing
specific file types within the preferences / options area.

TIP:  You can checkout resources from CERF and leave them checked out when you end your CERF session. You then
have the option to continue working with them in offline mode.

WORKING WITH METADATA

Metadata is information about your files in CERF. One of the outstanding features of CERF is its ability to add, display,
edit, manage and search for metadata. Click here for more information about metadata.

There are several different types of metadata that CERF can work with:

1. Embedded metadata, sometimes also called “file properties”. This is information embedded in your files before
they were added to CERF. Different applications you work with outside CERF might add any number of metadata values
to your files. For example, MS office often adds the name of the person who authored the file or the name of the
company that your copy of MS office is registered to. Another example is photos taken with your smart phone that
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often have metadata such as longitude and latitude embedded in them. Whenever possible, CERF will look inside your
files and display embedded metadata in the CERF Resource Info. CERF also adds this metadata to its database so that
you can use that information to search for those files using the CERF search engine. In the example below, the CERF
search engine was used to find photos taken with an iPhone at a specific latitude and longitude. Note that CERF did not
create this metadata, it merely extracted and indexed existing information that was already in the file.

TIP: If you do not see the metadata property you want to search for in the default list of search parameters in the
search tool, click Search Parameters > Metadata... to display a full list of many additional choices.

TIP:  You cannot currently edit embedded metadata in CERF, but you can add as much additional CERF metadata as
you like, as described below.

8 EREZLH#Ho &
Not Longitude  equals -97.7676 B IMG_1060.jpg
= Image Height: 2448
Not Latitude  equals ﬂ 30.264303 Image Width 3264
© Resolution
Horizontal Resolution: 72.0
Vertical Resolution: 72.0
) Resolution Unit: Inch
Add Search Parameter © And Or Save Search Find Experts Search @ -
© Equipment
Equipment Make: Apple
Showing 1 to 3 of 3 results. Equipment Model iPhone 5c
i Title Contrlbu(or Creation Date Last Update Reso.. Con.. Score ‘_EShutte.r Speed: 1/120 sec
IMG 1060.. Apr 17, 2018 4:50:13 PM__ [Apr 17, 2018 4:50:13 PM m- © Location
B MG_1060.. Rob One May 20, 2018 10:42:45 AM May 20, 2018 10:43:43 AM Image  JPEG Latitude: 30.264303
B IMG_1060.... Rob One May 20, 2018 10:36:22 AM May 20, 2018 10:36:22 AM Image JPEG 1 4 Longitude: -97.7676
Edit Metadata

2. CERF Annotations. Annotations are a type of informal, removable metadata that can be used to categorize CERF
resources and connect them to other data inside or outside of CER. Examples of annotations include Tags, Advanced
Tags, Notes, Ratings and Relations. A user must have a role of Annotator or higher in order to create annotation. Image
Annotations can be used to add searchable information and labels to images. CERF Annotations are not versioned, do
not affect the underlying data files and can be added and removed from any type of file in CERF at any time. Even
digitally signed or finalized files can be annotated.

There are several ways to create Relations in CERF but the easiest is to right-click and choose Edit > Add Relation, then
choose a relation type from the dialog box.

@) @ Choose Relation

Choose the type of relation to
add:

CERF Link/See Also

URL Link
Network File Link
Crossreference
Note

Gl e

Dragging and dropping one resource onto another can also be used to create CERF Relation Links (i.e. a way to show
that two CERF resources are related). Relations are listed at the top of the Resource Info, and some types of Annotations
(Tags, Ratings, Notes) can also be created there too without clicking “Edit Metadata” first. You can add as many Notes,
Tags and Relations as you like to a resource and delete them at any time by clicking the x icon next to each one.
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A special icon * is used to indicate that Notes or Relations are associated with a resource, and a red counter shows
how many of these there are in total (5 in this case).

In the example below, the file “01ab003468.gb” has the following Annotations:

e 2 Notes

e 1 “See Also” file reference (sectioning.m4v)

o 1 “See Also” folder reference (polytomella)

e 1 associated URL

e 2 Tags (sequence and DNA) Click either tags to open a new search window automatically set to search for
Parameter = “Tag”, Value = “sequence” or “DNA”

e Arating of “5 stars” (Stars can be used as an internal quality guide to the importance or quality of the data).

[ NON ] CERF v5.0.0 - Logged in to attic as robert1

=T &
S E+E Ot

¢
o

. © 01ab003468.0b

“ v 5] robertl -
= Relations and Annotations
ﬁ.] > | ABI trace files =
this is a sequence file @
[ v [ genbankfiles Note, Rob One, 6/12/18 6:55 PM
. (5] 01ab003468.gb this file is in genbank format ®
o Note, Rob One, 6/12/18 6:55 PM
v sectioning.m4v (1] sectioning.m4v @
> =9 (1] polytomella CERF Link/See Also, Rob One, 6/12/18 6:57 PM
» | compliance = © polviomella ®
N c 3 CERF Link/See Also, Rob One, 6/12/18 7:34 PM
rspace image copy.jpg https://www.ncbi.nlm.nih.gov/nuccore/KP299172.1 @
US 8.5 X 11 FLYER.indd URL. Roh One. 6/12/18 7°36 PM
) [ )
Table.sps \@ \_J \9
technical.rtfd Tags: sequence®, DNA®
Tahla? cnc Rating: ™ o o

3. CERF Metadata. This is more formal categorical information that can be associated with most resources in CERF

using the Edit Metadata icon » or the right-click > Edit > Edit Metadata command. Users can also open a Resource
Info window or panel and THEN click Edit Metadata. Users must have access role of Metadata Editor or higher to be able
to edit the values in CERF metadata categories. When you edit the CERF Metadata of a resource you are creating a new
version of that resource that will appear in the version history. Click here for more information on how to edit
metadata. Changes to formal metadata are versioned and are considered part of your official record. The Edit Metadata
window is shown below:

®00
© General
Title:
Description
Keywords
Comment.
Category:
© Submission/Modification
Resource Type
Creation Date
Last Update
Contributor:
File Size:
© Instantiation
Date 2017-06-16720:36:24Z %

Add More Metadata I Cancel

Semantic Type
Attribute >
User Supplied Basic CERF Metadata »
Annotations >
Dublin Core

Edit Metadata

sectioning.mév

=

Document

Juns, 2018 12:30:21 PM

Juns, 2018 12:30:21 PM
Rob One

57671464 Bytes

Save Metadata

Content >
Intellectual Property »
Instantiation 5
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https://cerfsupport.lab-notebook.org/user-manual/cerf-desktop-app/data-management/metadata/edit-metadata-inline/

Fields that include a delete icon (trash can) on the right are editable. Certain fields not editable for compliance reasons,
and fields displaying embedded metadata that are part of the file itself are also not editable.

If you don’t see the metadata type you want to add, try clicking Add More Metadata then choose a category from the
dropdown menu or sub-menus. Note that CERF includes dozens of additional ontologies and metadata categories that
you MIGHT see in the Add More Metadata dropdown. The options displayed there depend on the CERF Resource Type
you are looking at also how your admin has configured Domains on your server. Domains are used to allow different
types of researchers to have access to different types of specialized metadata categories and resource templates so that
they only see options that are relevant to their research. Users with a sufficient access role can add as many different
metadata fields and values as they like in the edit metadata window, and these all become searchable categories that
can be located with the CERF search engine. Note that CERF metadata created inside CERF is associated with your files
but is not physically inserted into them. Some metadata fields are not currently editable here because they are part of
the parent file (sometimes called “file properties”) this type of metadata is still displayed and indexed for searching by
CERF. A good example would be “instantiation Date” which is the date a file was first created, (not the date it was added
to CERF). Since this is a fixed value, it is not editable within the CERF “Edit Metadata” window.

When you export a file from CERF, it retains its original embedded metadata, but any CERF metadata you created is not
currently embedded inside the exported file, but may be included as an accompanying XML file. A good best practice is
to assign responsibility for appropriate metadata oversight to a specific specialist(s) in your organization then have them
ensure that everything in CERF is meaningfully labeled to make it easier to find in the future.

NEXT STEPS

Now that you have seen some of the key features in CERF you should find that the more detailed descriptions of CERF’s
advanced features in the user manual will be easier to follow. To continue learning more about CERF we suggest you
also read:

e  CERF 5 Advanced User Training Guide.pdf
e  CERF 5 PI's Guide_Lab-Ally.pdf

e The full user manual at https://cerfsupport.lab-notebook.org

Contact support@lab-ally.com for assistance with live training, formal User Certification
materials, IQ / OQ validation and on-site workflow analysis.
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